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How to use this Guide 
 
This document was written for the University of Auckland Financial Services department, as a guide to using 
PeopleSoft Financials -Billing and Accounts Receivable module. 
 
This document should be used in conjunction with the Introduction to PeopleSoft Financials Guide as a 
training aid for new staff and as a reference tool for experienced users. 
 
All financial transactions carried out on behalf of the University of Auckland must be performed in accordance 
with the UoA Financial Policies and Procedures as listed in the Introduction Guide. Financial Policies and 
Procedures are available on the Financial Services website. All users of PeopleSoft Financials must have read 
the relevant Financial Policies and Procedures. 

Throughout this guide: 

All steps required to execute a task are numbered.  
Additional information is bulleted. 
Fields that do not need to be populated are not included in the numbered steps.  
Additional Field descriptions are contained in Appendices. 
Bolded text denotes a corresponding field or value within PeopleSoft.  
Hyperlinks are underlined and coloured blue as visible within PeopleSoft.  
Note:  is used to inform of relevant information not covered in the steps. 

 

Related policy and guidelines 

 https://www.staff.auckland.ac.nz/en/central-services/finance-and-

purchasing/finance-user-manuals-and-guides.html 

 https://www.auckland.ac.nz/en/about/the-university/how-university-

works/policy-and-administration/finance/credit-management.html 
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Overview of Billing and Accounts Receivable 
 

Billing Process Diagram 

The diagram below shows the common business functions used in Billing and Accounts Receivable at the 
University of Auckland. 
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Billing 
 

Invoice Processing Flow 

The Invoice Processing flow starts with the input of Bills where customer information and invoice line details 
are added. A Bill can be printed only after it has been finalised. Once the invoice is generated the transaction 
is posted overnight to the General Ledger and the Accounts Receivable Ledger. 

Customer accounts and transactions can be reviewed and maintained using Inquiries, Reports and 
Conversations. 
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Billing 
 

Maintain Bills 
 

Enter Bills 

An invoice consists of a Bill Header, Bill Lines and Accounting Distribution lines. Header and Line Notes can be 
added to the invoice if required. A Bill is created with a status of NEW, and must be changed to Ready (RDY) 
before the invoice can be generated – finalised and printed. A Bill can only be raised in a foreign currency to a 
specified customer account. Currencies default according to the customers selected. There are a couple of 
ways to Enter Bills: 

• Express Billing 

• Copy Bills 

Express Bills 

To Enter a Bill using Express Billing, follow the steps below. 

Steps: 

1. From the Left Hand Navigation column click Billing. 

2. Click Maintain Bills. 

3. Click Express Billing. 

4. Click the Add A New Value tab. The Express Bill Entry Page will appear. 

 

 

 



Billing & Accounts Receivable User Manual  

V1 | last updated Tuesday, 6 November 2018 | 0.1 Final 

Page 5 of 55 

 

 

5. Select a Business Unit using the Lookup icon. 

Note:  Users will have a default Business Unit from their security setup. 

6. Fill in the Bill Type, Customer ID and Accounting Date. 

Note:  These can also be filled in in the next page as detailed in the following steps. 

7. Click Add. The Billing General page will appear. The default status of the Bill is NEW, and the next 
Invoice Number is yet to be allocated. 

 

8. Leave the status as ‘NEW’. 

Note:  If you want to work on the invoice for longer than a day, select status HOLD by using the search icon 
and select ‘HLD’. 

9. Using the lookup icon, select the appropriate Bill Type for your Faculty or Department in the 
corresponding field if you have not entered in the front page. 

10. Enter a Customer ID or search by using the Lookup icon if you have not entered in the front page. 
The customers default payment settings will populate the remaining mandatory fields. 

11. Using the Lookup icon, select the appropriate Bill Source. 

Note:  The Billing Source codes denotes the currency we expect to receive the invoice payment in. The 
Billing Source code will set the Remit To Bank details on the Bill. The general rules applied to Bill 
Source Codes are as follows: 

• If the Bill currency is NZD the Bill Source is set to NZD then the bank details shown on the Payment 
Information section of the Bill will be as follows: 

o  Remit To: ANZ 

o  Bank Account: NZD 
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• If the Bill currency is AUD the Bill Source is set to AUD then the bank details shown on the Payment 
Information section of the Bill will be as follows: 

o Remit To: ANZFX 

o Bank Account: AUD 

 

• If the Bill currency is EUR the Bill Source is set to EUR then the bank details shown on the Payment 
Information section of the Bill will be as follows: 

o Remit To: ANZFX 

o Bank Account: EUR 

 

• If the Bill currency is GBP the Bill Source is set to GBP then the bank details shown on the Payment 
Information section of the Bill will be as follows: 

o Remit To: ANZFX 

o Bank Account: GBP 

 

• If the Bill currency is USD the Bill Source is set to USD then the bank details shown on the Payment 
Information section of the Bill will be as follows: 

o Remit To: ANZFX 

o Bank Account: USD 

 

• If the Bill currency is another foreign currency where we don’t hold a bank account then the Bill 
Source is set to NZD then the bank details shown on the Payment Information section of the Bill will 
be as follows: 

o Remit To: ANZ 

o Bank Account: NZD 
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Below is a page showing the relevant codes for a NZD invoice: 

 

Below is a page showing the relevant codes for an AUD invoice: 
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12. Click the Address expand section to check customer details to ensure the correct Customer has been 
selected. 

Note:  Only use 7 digit numbers. Use Customer Maintenance Form FS-11 to request new customer being 
setup. Form is located on Financial Services’ webpage. 

Note:  Contact Names can be updated on Invoices. The primary contact will always default to the Express 
Bill page if available. To enter a new contact name, blank out the ‘Attention To’ field, a message 
will display, click OK and the ‘Contact Name’ field will then be updateable. See relevant screen 
prints below: 
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• The Contact name can then be changed to a new value which will print on the invoice, see relevant 
pages below: 

 

 

• The contact name entered will now print on the invoice, see below: 

 

 

 

Note:   See Appendix A for a full list of Billing Header Info page descriptions. 

13. Click the Header Detail expand section, the Header Detail page will appear. 

14. Enter the Accounting Date if you have not entered in the front page. 

15. Enter Billing Specialist. 

 

 

John Smith  
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Note:  The Billing Specialist code is mandatory on all invoices. This code holds the name of the person 
entering the Bill and holds additional details such as email address and telephone number which will 
print on the Invoice. Any new request for Billing Specialist codes to be setup can be channelled to the 
PeopleSoft SAS support team in the future. Below is the Billing Specialist code.   

 

 

16. Enter the PO reference in PO Ref. 

Note:  Customer records can be setup to require a Purchase Order. In this case, if a Purchase Order number 
isn’t entered, a warning message will be displayed asking for a Purchase Order Number to be entered 
before the invoice is finalised and printed. See warning message below: 

 

 

Note:  Not adding a Purchase Order Number on the invoice will not stop it from being processed. The 
Purchase Order number field should be entered in the PO Ref field in the Header Detail section of the 
Express Bill page. 

17. Collapse the Header Details section. 

18. In Bill Lines section, use the search icon to select ID in the Table field. 
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Note:  See Appendix A for a full list of the Bill Lines page field descriptions. 

19. Use the Lookup icon to select the appropriate tax Identifier (GST or ZEROGST). 

20. Enter a description of the bill line into the Description field. This will print on the invoice. 

21. Enter the Quantity into the corresponding field. 

22. The UOM defaults to EA (each). Override this if required. 

23. Enter the dollar value per unit into the Unit Price field. 

24. Press Enter. The Gross Extended field will calculate the value of the Goods or Services 
automatically. 

Note:  The GST will not be calculated and shown in the Gross Extended field until the finalisation process is 
run. If you want to check the tax information before finalisation see Summary hyperlink at the 
bottom. You need to save the bill before you can access the Summary hyperlink. 

25. To add another blank line to the Bill, enter a number in the Lines to Add box and Click the + icon.  
Complete the required fields in the new lines as above. 

26. To copy Bill Lines tick the selected line to copy under Sel. Enter a number in the Lines to Add box 
and click the Bill Line Copy Down icon. The new bill lines will be copied with identical field values.  
Change the values in the new bill lines as appropriate. 
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Note:  If a line is copied after Accounting Distributions have been allocated, the Bill Line and the Accounting 
Distributions will be copied. 

27. Click the Accounting Distribution hyperlink, the Accounting Distribution page will appear.  

28. Enter the Account and Dept codes into the corresponding fields. 

Note:  There are few ways of accessing Accounting Distribution page. You can also access it by clicking 
Revenue Account hyperlink in Bill Lines or by clicking Next in the Page Series at the right bottom 
corner as well as choosing from the drop down Navigation menu. 

29. If required enter Product and Project codes into the corresponding fields. 

30. Click the Refresh icon. The Amount fields will default from the bill line details previously entered. 

31. If required, add multiple Accounting Distribution Lines for the Bill line by clicking the + icon in the 
Bill Line Distribution panel. 

32. If you want to split the cost between accounts or departments, enter a Percentage into the 
corresponding field for each line. 

33. Click the Refresh icon, the Amount fields will recalculate based on the percentage entered. The 
total of all lines should equal 100%. 

34. Click Next from the Page Series icon. The Header Notes/Line Notes page tab will appear. If you need 
to enter any header or line specific notes, they are entered on this page in the Note Text box. This 
tab can also be accessed by clicking the Header Notes hyperlink or selecting Header-Note option from 
Navigation drop down menu. 

Note:  Header Notes appear on the top of the invoice and Line Notes appear on the bottom of each line. 

35. Go back to Billing General Page to change the status from New to Ready ‘RDY’ and click Save. The 
next invoice number is allocated and appears on the Header. 

36. Click the Summary hyperlink at the bottom of the page. The Bill Summary Info page will appear. 
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37. Click on Calculate Taxes tab. The GST portion of the bill will appear in the Total VAT Amount field. 
Make sure the GST amount is correct for the bill. 

 

 

38. Click Save. Click Express Billing Tab to go back to the bill. The invoice can be finalised and printed. 
See Generate Invoices section. 

Note:  All foreign customers are defaulted to NO GST. If GST needs to be charged on an invoice for a foreign 
customer, complete the additional steps below to ensure GST is correct; otherwise save as per step 
38.  
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Additional GST Steps: 

1. From the Navigation drop down menu, select Line-VAT. 

2. Click on VAT Details to expand the section. 

3. In the section of VAT Details, use the Lookup icon in the VAT Code field to select GST and in the 
Transaction Type field to select GST. 

4. Click the Adjust Affected VAT Defaults tab and Save. 

 

 

5. Go back to Billing General Page to change the status from New to Ready ‘RDY’. 

6. Click Save. The next invoice number is allocated and appears on the Header. The invoice can be 
finalised and printed. See the Generate Invoices section. 
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Adding an attachment to a bill/Supporting Documentation Steps: 

1. Click the Attachments hyperlink at the bottom of the billing general tab. Header Documentation 
page will appear. 

2. Click upload. A File Attachment window will appear. 

3. Select a document you want to attach to the bill by clicking Browse and upload the document. 

4. Enter a document description and click Save. You can view the attached document by clicking View 
button. 

5. Select Express Billing Tab to go back to the Bill page. 

Note:  If you would like to view the attached documents in the future, access Billing/Maintain 
Bills/Supporting Documentation. Enter Business unit and Invoice number. Click search. 

 

 

Note: Attachments to Bills have a number showing on the page against the Attachments hyperlink to denote 
the number of documents attached to a Bill. 
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Copy Bills 

To improve efficiency in creating bills, you can copy a similar existing bill and alter it. 

Steps: 

1. Access Billing>Maintain Bills>Copy Single Bill. The Copy Single Bill page will appear. 

2. Use the Lookup icons to select a Business Unit and an existing Invoice ID to copy. 

3. Click Search. If more than one match is listed, click the hyperlink of the invoice you wish to copy. 

4. In the Select Bill Action panel, select the Copy Bill radio button. 

5. Click Save. The Bill number for the new Bill will be displayed in the Copy Bill field. 

 

 

6. Click the Go to Bill Header - Gen Info hyperlink. The Billing General page will appear displaying the 
new bill in Status NEW with a blank invoice date. 

7. Change the Customer ID if required. Click OK to confirm. 

8. Go to Header Detail section to enter the Accounting Date. 

9. Make any further required changes to the Header and/or Lines sections. 

10. Go back to Billing General page to change the status to RDY. 

11. Click Save. The invoice can be finalised and printed. See the Generate Invoices section. 
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Generate Invoices 

Finalisation 

The finalisation process changes the status of Bill(s) from RDY to INV and calculates the GST component. If 
errors in a bill are found after finalisation, a Credit Note must be raised. To finalise a single invoice or a batch 
of invoices follow the steps below: 

Steps: 

1. If not already in the Invoice you want to finalise, click Billing>Maintain Bills>Express Billing. Find an 
Existing Value page will appear. Use the Lookup icon to select a Business Unit and an existing.    

2. Click Search. 

3. Change the Bill Status to Ready ‘RDY’ if not already. 

4. To run the invoice, click on the   icon on the bill page. 
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5.  When you click on the icon the following message appears:  

 

 

 

6. Click on the OK box. 

7. Click the Process Monitor hyperlink.  

8. A new window Process List will appear. A PeopleSoft Job called UOABIJOB is submitted. 

9. Click Refresh button periodically until the Run status changes from Queued to Success. 

10. Click on the UOABIJOB process and the following page displays: 

 

 

 

 

11. Click on the UOAPRNT01 process. 
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12. Click on View Log/Trace option. 

 

 

13. Select UOA_XMLP_INV.pdf option to view the Tax Invoice and Print. 
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Note:  The finalise and print process can be run together and submitted via an icon on the bill page. 

Note:  You can use the Page Series buttons displaying on the bottom right hand of the Billing pages to move 
through the different Billing pages. See the Prev and Next buttons shown below: 
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Invoice Reprints 

The following steps are to be followed for re-printing of invoices. 

Option 1 

Steps: 

1. Access Billing>Locate Bills>Bills Invoiced. 

2. Enter Customer ID number and click Search. 

3. Select the item you wish to re-print. 

4. Click on the   button and a new window page, Invoice Reprint Overrides will display. 
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Note:   The output destination must always be set to Web. 

5. Select Output Destination to Web and then click OK button. A process called ‘UOABIJB2’ is run. 

6. Access the bill within the Process Monitor: People Tools>Process Scheduler>Process Monitor. Click 
on the process name of UOABIJB2 and follow the Generate Invoice steps 7 to 13. 

 

 

Option 2 

Steps: 

1. Access Billing>Generate Invoices>Non-Consolidated>Reprint Invoices. The Invoice Register Run 
Control page will appear. 

2. Click Add A New Value. 

3. In the Run Control field, type PRINTINV. 

4. Click Add. The Reprint Invoice page will appear. 

5. Select a Business Unit and Invoice Number using the Lookup icon. 

 

 

 



Billing & Accounts Receivable User Manual  

V1 | last updated Tuesday, 6 November 2018 | 0.1 Final 

Page 23 of 55 

 

 

 

 

6. Click Run. The Process Scheduler Request page will appear. A process called UOABIJB2 is run. 

 

 

7. Use the Server Name drop down box to select PSNT2. 

8. Place a checkmark beside the report you wish to print. 

9. Click OK. 

10. The Process Instance Number will be displayed under the Run button. 

11. Click the Process Monitor hyperlink. Follow the Generate Invoice steps 7 to 13. 
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Option 3 

Steps: 

1. Access Main Menu>Accounts Receivable>Customer Accounts>Customer Information>Account 
Overview. 

2. Select the Unit as ‘UOA’ which is the AR Business Unit and enter a valid Customer ID. Click Search. 

3. Click the Profile tab, then click Item List hyperlink. Customer Item Inquiry page will appear.  

4. Select the Item you wish to reprint and select the ‘Reprint Invoices’ option as the Item Action. Then 
click on the GO button. The Invoice Reprint Overrides page will appears. 

5. Ensure the Output Destination says Web then click on the OK button. A process called UOABIJB2 is 
run. 
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Note:  Reprinted Invoices/Credit Notes will have the wording ‘REPRINT’ printed on the document. See 
example below: 

 

 

Note:  Once an invoice is finalised any future printing of the invoice will show the wording ‘REPRINT’. 
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Note:  Payment Link for Credit Card as the method of payment. The payment link will display at the bottom 
of the invoice for NZD related invoices as follows: 

 

 

• When customers click on the Pay by Credit Card link the following page displays. 

  

 

 

Note:  Customers can enter the relevant payment details in this link. Note the Payment link is only 
applicable to NZD invoices. The link will not display on foreign currency invoices or credit notes. For 
Draft invoices the link displays but is not available to be used. 

Note:  If a customer is not able to receive/open the PDF version of the invoice, the link below can be sent to 
them: External 
https://sec.paymentexpress.com/pxaccess/pxpay/payform?userid=UOARevenueCollection_External  

 

 

 

 

https://sec.paymentexpress.com/pxaccess/pxpay/payform?userid=UOARevenueCollection_External
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Review Billing Info 

The Bill Summary page provides you with a snapshot of your Bill Header and Lines information. It is useful for 
checking the Bill Status and Processing Status at any time. 

Bill Summary – Before Finalisation 

You can check the tax information on an invoice before you finalise it by accessing the Bill Summary pages. 
The tax totals displayed are estimates until Finalization is run. 

Steps: 

1. Access Billing>Maintain Bills>Bill Summary. The Bill Summary search page will appear. 

2. Use the Lookup icons to select a Business Unit and an existing Invoice ID. 

3. Click Search. The Bill Summary Info page will appear. 

 

 

 

4. Click the Calculate Taxes icon. A GST estimate displays in the Total VAT amount field. 

5. Check the Bill details displayed, Customer, Amounts and Bill Status. 

6. Click the Bill Summary Info 2 page tab. The check boxes are ticked to show processing phase for the 
bill. For example, VAT applied or Invoice Printed. 

Note:  Access the Bill Header, Lines and Notes via the hyperlinks at bottom of page. 
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Generating Pro-Forma or Draft Invoice 

A Pro-forma or Draft invoice can be run multiple times and is typically run to verify the layout of the invoice 
before finalising it. Changes can be made to the invoices if required. A Pro-forma or Draft invoice can be 
produced any time, this can be submitted via an icon on the Bill page. 

Note:  A Pro-forma or Draft invoice can be run if the Bill Status field has a value of either ‘RDY’ for Ready, 
‘NEW’ for New or ‘HLD’ for Hold. 

Note:  Once a Pro-forma or Draft invoice is run you must exit the relevant Bill page and call it back up if you 
want to finalise and print the invoice. 

Steps: 

1. Access Billing>Maintain Bills>Express Billing. The Express Bill Entry page will appear. 

2. Use the Lookup icons to select a Business Unit and an existing Invoice ID/or follow the step for a 
new bill. 

3. Click Search. The Billing General page will appear. 

4. To run the Pro-forma or Draft invoice click on the   Pro Firma icon on the Bill page. 

 

 

Note:  Pro-forma or Draft invoices should not be sent out to third parties, they are NOT Tax invoices. They 
should only be used for internal purposes to check the way the Bill will print out. 

5. When you click Pro Forma icon, the following message appears. Click OK. A PeopleSoft Job called 
UOABIJOB is submitted. 
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Note:  If you wish, you then can watch the process run by clicking on the Process Monitor option that now 
appears on the Bill page.  

6. Click Process Monitor hyperlink. Process List will appear. 

 

 

7. Click on the UOABIJOB hyperlink. 

 

 

8. Click on the UOAPRNT01 process then View Log/Trace options. 
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9. Click on UOA_XMLP_INV.pdf option to view the Pro-forma/Draft invoice. 

 

 

 

Note:  The Pro-forma/Draft invoice can also be run using the following navigation: 

Steps: 

1. Access Billing>Generate Invoices>Non-Consolidated>Print Pro Forma. Pro Forma page will appear. 

2. Click Add a New Value. Enter Run Control ID: ‘BI_PROFORMA’. Click Add. 

Note:  Create a new Run Control ID the first time you use this eg: ‘BI_PROFORMA’. Once created you can use 
this for all processes in the future. 

3. Using Lookup icon, select the Business Unit and the Invoice Number. 
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4. Click Run button. The Process Scheduler Request window will appear. 

5. Select UOABIJOB and click OK box to run the process. 

6. Follow Process Monitor steps to view Pro-forma/Draft Invoice. 
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Bill Summary – After Finalisation 

You can check the tax information on an invoice after finalisation by accessing the Bill Summary pages. The 
tax totals displayed are finalised and Bill Status is INV. 

Steps: 

1. Access Billing>Review Billing Information>Summary. The Bill Summary search page will appear. 

2. Use the lookup icons to select a Business Unit and an existing Invoice ID.  

3. Click Search. The Bill Summary Info page will appear. 

 

 

4. Check the bill details displayed, amounts, VAT, Customer and Bill Status. 

5. Click the Bill Summary Info 2 page tab for more detail. The check boxes are ticked to show 
processing phase for the bill. For example, VAT applied, Invoice Printed, General Ledger entries 
created, and Accounts Receivable updated. 

Note:  The Header, Lines and Notes for the bill can be accessed via the hyperlinks on the bottom of the Bill 
Summary Info pages or via the Left Hand Navigation column. 
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Credit Adjustments 

Credits can be processed to adjust the value of either the entire Bill or individual lines on a Bill. Depending on 
your requirements, there are three options for processing credit adjustments: 

• Credit Entire Bill – Use Adjust Entire Bill function to credit the entire invoice. 

• Full Credit Bill Line(s) – Use Credit Line function to credit the total value of one or more lines of a 
Bill. 

• Partial Credit Bill Line– Use Net Adjustment Only function to reduce the value of one or more 
lines on a Bill by creating a partial credit. 

Note:  Please also note that journals, rather than credit adjustments, are the appropriate tool for making 
any required changes to the general ledger coding on posted Bills. 

Credit Entire Bill 

Steps: 

1. Access Billing>Maintain Bills>Adjust Entire Bill. The Adjust Entire Bill search page will appear. 

2. Enter a Business Unit or use the Lookup icons to select one. 

3. Enter the Invoice ID for the bill you want to credit. 

Note:  If you do not know the Invoice number, search for it by entering the Business Unit only and clicking 
search. Narrow search results by selecting a Customer using the lookup icon in the Customer field. 

4. Click Search. The Adjust Entire Bill page appears. The Customer and Invoice details for the bill to be 
credited are displayed in the header. 

 

 

5. Under Select Bill Adjustment select the Credit Entire Bill radio button. 

6. Click Save. The select an Adjustment Reason message will appear. 
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7. Click OK. Choose a credit reason from the Adjustment Reason lookup icon. 

 

 

8. Click Save. The Adjustment Results box is greyed out and shows the credit bill number allocated. 

9. Click the Header Info 1 hyperlink beside the Credit Bill number. The Billing General page for the 
credit bill is displayed. The default status for the credit bill is RDY. All other fields default from the 
original bill. 

10. Confirm the Pretax Amt has defaulted to show as a negative (credit) amount. 

11. Enter the Accounting Date in the Header Detail section. 

12. Click the Next hyperlink in the Page Series box. The Header Notes page appears. 

13. Enter a reason for raising a credit note into the Bill Header Note Text box. This reason applies to the 
entire bill. 

14. Click Save. A saved message returns in the top right of the page. The credit note is saved. 

15. Click the Approvals hyperlink at the bottom of the page. The Approvals page will appear. 

 

 

 

 



Billing & Accounts Receivable User Manual  

V1 | last updated Tuesday, 6 November 2018 | 0.1 Final 

Page 35 of 55 

 

 

 

 

 

 

16. Fill in the Comment filed in the Approvals page with a detailed reason of the credit note and click 
Submit for Approval. Click OK. The credit note will be work flowed to the Business Unit finance 
manager for approval. 
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17. Approvals status can be reviewed by going back to the Approvals page. The Approval Monitor 
hyperlink can provide the information of where the approval is sitting with. 

 

 

18. Once a credit note is approved by the Finance Manager, the billing user will be sent an email to 
confirm the credit note is ready to be finalised.  

19. To finalise the credit note, follow generate invoice - finalisation steps: click the Invoice icon on the 
bill page, top right corner. 

Note:  A credit note can only be finalised once it has been approved by the Finance Manager. 

 

 

 

 

 



Billing & Accounts Receivable User Manual  

V1 | last updated Tuesday, 6 November 2018 | 0.1 Final 

Page 37 of 55 

 

 

Credit Entire Line(s) 

Steps: 

1. Access Billing>Maintain Bills>Adjust Selected Bill Lines. The Adjust Selected Bill Lines search page 
will appear. 

2. Enter a Business Unit or use the Lookup icons to select one. 

3. Enter the Invoice ID for the bill you want to adjust. 

Note:  If you do not know the invoice number, search for it by entering the Business Unit only and clicking 
search. Narrow search results by selecting a Customer using the lookup icon in the Customer field. 

4. Click Search. The Adjust Selected Bill Lines page appears. The Customer and Invoice details for the 
bill to be adjusted are displayed in the header. Click View All to see all the lines. 

 

 

5. Under Line Adjustment Parameters select Adjust Selected Lines radio button. Do NOT tick the Add 
to Existing Bill box and click on OK. 

6. Click on the Line Opt drop down box. 

7. Click Credit Line from the drop down list. Chose an adjustment reason from the Adjustment Reason 
Default field. Tick the line you would like to credit and choose a reason from the Adjustment Reason 
field of the line and click on Save. A new invoice number appears under the Line Adjustment Results. 

8. Click the Header Info 1 hyperlink beside the Credit Note number. The Billing General page for the 
credit bill is displayed. The default status for the credit bill is NEW. All other fields default from the 
original bill. 
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9. Enter the Accounting Date in the Header Detail section. 

10. Go back to Billing General and change the status to RDY. 
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11. Click the Next hyperlink in the Page Series box. The Header Notes page appears. 

12. Enter a reason for raising a credit note into the Bill Header Note Text box. This reason applies to the 
entire bill. 

14. Click Save. A saved message returns in the top right of the page. The credit note is saved. 

15. Click the Approvals hyperlink at the bottom of the page. The Approvals page will appear. 

16. Fill in the Comment filed in the Approvals page with a detailed reason of the credit note and click 
Submit for Approval. The credit note will be work flowed to the Business Unit finance manager for 
approval. 

17. Approvals status can be reviewed by going back to the Approvals page. The Approval Monitor 
hyperlink can provide the information of where the approval is sitting with. 

18. Once a credit note is approved by the Finance Manager, the billing user will be sent an email to 
confirm the credit note is ready to be finalised. 

19. To finalise the credit note, follow generate invoice - finalisation steps: click the Invoice icon on the 
bill page, top right corner. 

Note:  A credit note can only be finalised once it has been approved by the Finance Manager. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Billing & Accounts Receivable User Manual  

V1 | last updated Tuesday, 6 November 2018 | 0.1 Final 

Page 40 of 55 

 

 

Partial Line Credits 

Steps: 

1. Access Billing>Maintain Bills>Adjust Selected Bill Lines. The Adjust Selected Bill Lines search page 
will appear. 

2. Enter a Business Unit or use the Lookup icons to select one. 

3. Enter the Invoice ID for the bill you want to adjust. 

Note:  If you do not know the invoice number, search for it by entering the Business Unit only and clicking 
search. Narrow search results by selecting a Customer using the lookup icon in the Customer field. 

4. Click Search. The Adjust Selected Bill Lines page appears. The Customer and Invoice details for the 
bill to be adjusted are displayed in the header. Click View All to see all the lines. 

5. Under Line Adjustment Parameters select Adjust Selected Lines radio button. Do NOT tick the Add 
to Existing Bill box and click on OK. 

6. Click on the Line Opt drop down box. 

 

 

7. Click Create Net Adjustment Only from the drop down list. Chose an adjustment reason from both 
the Adjustment Reason Default field. Tick the line you would like to credit. Choose a reason from 
the Adjustment Reason field of the line and click on Save. A new invoice number appears under the 
Line Adjustment Results. 

8. Click the Header Info 1 hyperlink beside the Credit Note number. The Billing General page for the 
credit bill is displayed. The default status for the credit bill is NEW. All other fields default from the 
original bill. 

9. Enter the Accounting date in Header Detail. 

10. In the Bill Lines section, change the quantity to a negative figure and enter the unit price of the 
reduced net value in the Unit Price field. Click Refresh, the Gross extended amount appears. 
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11. Change the bill status to RDY. 

12. Click the Next hyperlink in the Page Series box. The Header Notes page appears.  

13. Enter a reason for raising a credit note into the Bill Header Note Text box. This reason applies to the 
entire bill. 

14. Click Save. A saved message returns in the top right of the page. The credit note is saved. 

15. Click the Approvals hyperlink at the bottom of the page. The Approvals page will appear. 

16. Fill in the Comment filed in the Approvals page with a detailed reason of the credit note and click 
Submit for Approval. The credit note will be work flowed to the Business Unit finance manager for 
approval. 

17. Approvals status can be reviewed by going back to the Approvals page. The Approval Monitor 
hyperlink can provide the information of where the approval is sitting with. 

18. Once a credit note is approved by the Finance Manager, the billing user will be sent an email to 
confirm the credit note is ready to be finalised. 

19. To finalise the credit note, follow generate invoice - finalisation steps: click the Invoice icon on the 
bill page, top right corner. 

Note:  A credit note can only be finalised once it has been approved by the Finance Manager. 
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Additional Notes to Short Courses 

For bill type ES – Executive Programmes 2, additional steps have been created to meet the deferred revenue 
requirements. Based on the Express Bill steps, the following steps are to be followed for all the ES bills. 

1. Under Header details click Order Management and select an Order Date – this date is the actual 
course date. 

 

 

2. Identifier – SC01 is designed for the standard identifier for all ES invoices. By choosing this identifier 
account code is default to 625. 

 

 

3. Line Information –click on Line Information tab. Revenue recognition basis is selected as Order Date. 
This will decide if a deferred revenue journal needs to be created. 

 

 

Note:  Once the course has started, a journal will be created by AR between the deferred revenue and 
current sales account codes. 
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Accounts Receivable 

Accounts Receivable holds all the information about customer account balances. It is possible to view 
customer accounts, outstanding invoices, payment details and customer conversations. 

Customer Accounts 

View Outstanding Invoices on an Account 

Users can go to customer accounts to view outstanding invoices. 

Steps: 

1. Access Accounts Receivable>Customer Accounts>Customer Information>Account Overview. 

2. Enter a Unit of UOA. 

3. Type the Customer ID into the corresponding field. Use the Lookup icon if required. 

4. Click Search. The customer name and customer Most Recent Activity page will appear. 

 

 

 

5. Click the Customer Action tab. 

6. Click Search on the Customer Action page. The Item List hyperlink will appear. 
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7. Click the Item List link. A new window will open with a list of outstanding invoices for the customer. 

8. Use the drop down box to change the *Status from Open to All. 

9. Click Search. A list of all invoices ever charged to the customer will be displayed.  
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Confirm Invoice Payment 

Steps: 

1. Access Accounts Receivable>Customer Accounts>Item Information>Item Activity Summary. 

2. Type UOA into the Business Unit field. 

3. Type the Invoice Number into the Item ID field. 

4. Click Search. Item Activity page will appear. Sequence 1 shows the item information and Sequence 2 
shows the payment/credit information. 

Note:  Sequence 2 will only show if the invoice has been paid, credited or written off to bad debt. Entry 
Type decides if it has been paid, credited or written off. 
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Customer Conversations 

This function is used by both Billing Clerks and staff in Financial Services to record information about contact 
with customers. It is essential that any information shared with a customer about a particular invoice is 
recorded. 

Add a Conversation 

To enter a conversation please use one of the following navigation paths based on your access in PeopleSoft:    

Option 1 

Steps: 

1. From the Left Hand Navigation column, access Customers>Conversations>Update Conversations. 

2. Click Add A New Value. 

3. Type UOFAK into the Set ID field and UOA into the Business Unit Field. 

4. Type in the Customer ID you wish to add a conversation to. 

5. Click Add. 

 

 

 

 

Option 2 

Steps: 

1. From the Left Hand Navigation column, access Accounts Receivable>Customer 
Interactions>Conversations>View>Update Conversations. 

2. Click Add A New Value. 

3. Type UOFAK into the Set ID field and UOA into the Business Unit Field. 

4. Type in the Customer ID you wish to add a conversation to. 

5. Click Add. 
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6. From the Conversations tab, use the Lookup icon to select a Subject. 

7. Use the Lookup icon to select a Sub-topic. 

8. Type the Invoice number the conversation relates to and a brief Description of the conversation into 
the corresponding field. 

 Note:  If a conversation relates to a particular Invoice number, adding that Number to the Description field 
will make it easier to locate when Reviewing Conversation. 

9. Type a full description of the conversation and the relevant Invoice Number/s into the Comments 
field. 

10. Click Save. The Conversation will save in status New. 
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Note:  The important information to enter on a conversation is as follows: 

• Description: Enter the relevant description of what the conversation is about. 

• Subject: Choose the relevant Subject of the conversation. 

• Sub-Topic: Choose the relevant Sub-Topic of the conversation. 

• Contact ID: Choose the Customer Contact ID relating to the conversation if available. 

• Comments: Enter relevant Comments relating to the conversation. 

Note:  The   tab allows you to tie a conversation to invoices. Enter ‘I’ in the Qualifier field 
and then a relevant Invoice Number in the Reference ID field. 

 

 

Note:  The    tab allows you to attach documents relating to the conversation. This is 
optional but should be used where applicable. 
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Review a Conversation 

Steps: 

1. Access Accounts Receivable>Customer Interactions>Conversations>View>Update Conversations. 

2. Click Find An Existing Value. 

3. Type UOFAK into the Set ID field and UOA into the Business Unit field. 

4. Type the Customer ID you wish to search on into the Cust ID field. 

5. Click Search. A list of conversations for that customer will appear. 

6. Click on the conversation you wish to view. 

Note:  Once the issue has been resolved, use the drop down box to change the status to Closed. Save the 
change. 
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Query Reporting Tool 
 

Run an Existing Accounts Receivable Query 

Steps: 

1. Access Reporting Tools>Query>Query Viewer. The Query Viewer page will appear. 

2. Choose Query Name in the Searched By drop box. 

3. In the free text search field, type ‘UOA_AR’. 

4. Click Search. A list of existing Accounts Receivable queries displays. 

5. Click the Run hyperlink of the query you wish to use. For this example, select the Run to HTML 
alongside the query “UOA_AR_CUSTOMER_INVOICES”. A new window opens and parameter fields will 
be displayed if required. 

6. Enter the parameters for your query as prompted. The example shown below is A Customer Invoices 
query.  

Note:   ‘%’ can be used as a wildcard for partial number searches. 

 

 

7. Click the View Results icon. The query results will display on the screen. This example shows 
Customer Invoices By Customer. 

8. To select a different query, close this window and return to the main page. 

9. To run the query with different parameters, change the parameter fields, then click the View Results 
icon. The results are refreshed on the page. 

10. To save the results, click the Excel Spreadsheet hyperlink. The results are displayed in the browser in 
excel format. You must save as an excel file by selecting File/Save As from the browser toolbar. 
Select a file directory, File Name, and ensure the file type selected is .xls. Open the excel application 
and retrieve this excel file in the normal manner to use/manipulate the query. 

11. Click the browser back arrow to return to the query results screen. 
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Run an Existing Billing Query 

Steps: 

1. Access Reporting Tools>Query>Query Viewer. The Query Viewer page will appear. 

2. Choose Query Name in the Searched By drop box. 

3. In the free text search field, type ‘UOA_BI’. 

4. Click Search. A list of existing Billing queries displays. 

5. Click the Run hyperlink of the query you wish to use. For this example, select the Run to HTML 
alongside the query “UOA_BI_INVOICES_BY_BU”. A new window opens and parameter fields will be 
displayed if required. 

6. Enter the parameters for your query as prompted. The example shown below is an Invoice Status 
query. 

 

 

7. Click View Results icon. The query results will display on the screen. This example shows a list of 
invoices raised within the period for the Business Unite selected. 

8. To select a different query, close this window and return to the main page. 

9. To rerun the query with different parameters, change the parameter fields, click the View Results 
icon. The results are refreshed on the page. 

10. To save the results, click the Excel Spreadsheet hyperlink. The results are displayed in the browser in 
excel format. You must save as an excel file by selecting File/Save As from the browser toolbar. 
Select a file directory, File Name, and ensure the file type selected is .xls. Open the excel application 
and retrieve this excel file in the normal manner to use/manipulate the query. 

11. Click the browser back arrow to return to the query results screen. 
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APPENDIX A Field Descriptions 

Billing General page fields’ descriptions: 

Note:   * denotes required field. 

 

Field   Description 

Unit   Your Business Unit – see Appendix B for a complete list.  

Invoice   Defaults to Next until invoice is saved, then displays Invoice ID.  

Pre tax Amount  Total of all bill lines before tax. 

Status   Displays current status of the bill. Defaults to New. 

Invoice Dt  Date of invoice. Defaults to the Accounting Date. 

*Bill Type  A Bill Type code that denotes the type of bill being processed. 

Source   Determines the source of bill entry. Defaults to Customer Currency. 

*Frequency Only relevant to Recurring Bills. Determines the frequency of bill generation.  
Defaults to Once. 

*Customer  Lookup displays a list of active UoA customers. 

Address   Access to view the customer address page. 

SubCust1  Local, Overseas or Research customers. Used for reporting purposes. 

Cycle ID   Determines the schedule for bill generation. Defaults to DAILY. 

*Invoice Form  Defaults to XMLPUB. Denotes the file format of a printed invoice. 

From Date  Denotes the date that services were provided from. 

To Date   Denotes the date that services were provided to. 

Pay Terms Denotes the terms of payment as agreed with the customer. Defaults to the 20th , 
representing due 20th of next month. 

Pay Method Defaults to Check (Cheque). Denotes the payment method as agreed with the 
customer. 

Remit To Defaults to ANZ for NZ customers and ANZFX for foreign customers - All customer 
payments are deposited into the ANZ Bank. 

Bank Account  The currency expected to receive the invoice payment in. 

Acctg Date  Date invoice is process to the General Ledger and Accounts Receivable modules. 

Revenue Account  To enter and display Account/Department/Project chart fields for the bill. 

Sales Person  Field populates automatically from Customer record. 

Bill Inquiry Phone  UoA contact number for customer account inquiries. 

Credit Analyst  Field populates automatically from Customer record. 

Collector  Field populates automatically from Customer record. 

Biller   Field populates automatically from Customer record.  

*Billing Specialist  A billing specialist who is responsible for entering the Bill.  
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Billing Authority  Not used.  

*PO Ref   Customer Purchase Order Number. 

Copy Address  Access to view the courtesy customer address page. 

Header Notes Access the Header Notes page. The note appears at the top of the invoice and 
relates to all lines of the invoice. 

Standard Entry  Click to toggle between standard and express bill entry. 

Summary  Access to the bill summary page. 

Bill Search  Hyperlink to the corresponding action in the Left Hand Navigation column. 

Line Search  Hyperlink to the corresponding action in the Left Hand Navigation column. 

Table   Identifier for Billing. Use ID identifier only. 

Description  Free text field to describe the bill line item ordered by the customer. 

Identifier  Tax indicator. 

Quantity   Free text field. Number of goods or services provided. 

UOM   Unit Of Measure. 

Unit Price  Cost per unit of goods or services provided.  

Gross Extended  Total value of goods or services provided. 

Lines to Add  Used to add, subtract or copy lines from the bill. 
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APPENDIX B Billing Business Units and Bill Type Codes 

 

Business Unit Description Bill Type Description 

AF Faculty of Arts AF 
FB 
TH 

Arts 
Fale Booking 
Theology 

AI Asian Institute AI Asia Institute 

AS Academic Services CA 
CE 

Academic Development 
Continuing Education 

AT Creative Arts and Industries AT 
FR 

Appfa Faculty 
Fine Arts 

BE Business and Economics BE 
ES 

Business and Economics 
Executive Programmes 2  

BN Akl Bioengineering Institute BN Akl Bioengineering Institute 

ED Faculty of Education ED 
EF 

Faculty of Education  
Faculty of Education - Epsom 

EN School of Engineering BN 
EN 

Bio-Engineering 
Engineering 

ER External relations CM 
ER 
SP 

Communications and Marketing  
External Relations 
Schools Partnership Office 

EX Vice-Chancellor’s Office EX 
SH 

Executive 
Shared Services 

FS Financial Services FS Financial Services 

HR Human Resources HR Human Resources 

IP Institute Prof Legal Studies IP Institute Prof Legal Studies  

IT IT Services CN 
IT 

Data Network  - ITSS 
ITSS 

LB Library LB Library 

LG Liggins LG Liggins 

LW Faculty of Law LW Law 

MD Medical and Health Science BS  
CL 
CS 
MA 
MC 
OP 
PH 
SN 
SS 

Biomedical Science  
Clinics 
Clinical Sciences 
Administration Medicine  
Contracts 
Optometry 
Population Health 
Nursing 
Support Services 

MT Maidment Theatre MT Maidment Theatre 

PS Property Services PS Property Services 

ROC Research Office FP 
TM 

Fixed Price 
Time and Materials 

SA Student Administration AR 
GC 
IO 
RL 
SA 

Academic Registry 
Graduate Centre 
International Office 
Commercial Services CL 
Student Administration 

SC Faculty of Science SC Science 

ST Student Services ST Careers Advisory 

SU Student Support SU Scholarships and Financial Support 

TR Tamaki Registry TR Tamaki Registry 
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APPENDIX C Bill Status List 

Any one of the following Statuses can be displayed in the Status field on the Bill Header. A user can manually 
adjust the status or it can be changed automatically by running a process. 
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